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1. Background

Monitoring of lung function in at-risk populations enables the identification of
individuals with excessive decline of lung function. The spirometry test of forced
expiratory volume in one second (FEV)) is the measure best suited for monitoring
changes in lung function over time. An excessive decline in FEV; over several years can
indicate development of lung disease and has been shown to be associated with increased
respiratory morbidity, loss of productivity at an earlier age, and increased mortality.'”

The Spirometry Longitudinal Data Analysis (SPIROLA) software is an integrated visual
and quantitative tool to aid in monitoring lung function in individuals participating in
spirometry-based health monitoring programs. To ensure that individuals with excessive
decline in lung function can be identified accurately and in timely manner, it is important
to maintain acceptable precision of the longitudinal spirometry data. In order to maintain
data precision at an acceptable level, SPIROLA enables the user to monitor longitudinal
data precision and spirometry quality grades for the monitoring program, this provides
also a basis on which to determine an appropriate limit of longitudinal decline in
individuals.*® SPIROLA may help to preserve lung function through identification of
excessive decline followed by appropriate intervention. The intervention function helps
the user to obtain information on potential risk factors, and plan, record, and evaluate the
effect of intervention strategies. SPIROLA provides the following functions:

For an individual:

e [t monitors the level of FEV; and FVC in relation to criteria for assessment of cross-
sectional data: the lower limit of normal (LLN) (i.e., the lower st percentile) and the
lower 0.1™ percentile (approximately comparable to 60% predicted).

e It monitors FEV, change over time in relation to criteria for assessment of
longitudinal changes: the limit of longitudinal decline (LLD).

e It provides interpretation of the rate of FEV, decline and data variability in an
individual’s summary report and suggests actions to prevent further excessive loss.

e It enables to plan, record, and evaluate intervention measures.

For a group of individuals:

e It monitors longitudinal data precision using the pair-wise estimate of within-person
variation s, (absolute) or s; (relative).*®

e It monitors group means for observed, predicted and z-score for FEV; and FVC to
enable the user to identify time-related changes taking place at a group level.

e It monitors statistics on the spirometry quality grades, as provided by a spirometry
system, as a percentage of testing sessions that do not meet the 2005 ATS/ERS
criteria for acceptability and repeatability, overall and by individual technicians.

e It provides statistics and lists of individuals whose lung function tests fall below the
LLN and whose rate of lung function decline and variability may be excessive.
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2. SPIROLA Installation

SPIROLA runs on PC with Microsoft Windows system. For detailed software
requirements see Appendix.

1. Open NIOSH SPIROLA webpage http://www.cdc.gov/niosh/topics/spirometry/spirola.html.

2. Click Software Download to download SPIROLA.

3. Click Run button on the File Download window to start setup procedure. (If a
warning "Publisher could not be verified" appears, click Run button to continue the
installation.) If Run does not work, click Save on the File Download and save the
setup file on the local C: drive (e.g., C:\SpirolaSetup) and then run on the local drive.

4. Follow instructions specified by the installation procedure. User needs to read and
agree with a DISCLAIMER to install and use the software. Click Next> to proceed.

5. The Select Installation Folder window will appear, as shown below. By default,
SPIROLA is installed into C:\SPIROLA folder. The user can override this default
setting by designating an alternative location. Click Next> to proceed.

i SPIROLA (@=.3

Select Installation Folder ! "

The installer will install SPIROLA to the following folder.

Ta installin this folder, click "Mest". To install to a different falder, enter it below or click "Browse".

Folder:

C:ASPIROLAN Browse...
Disk Cost...

’ Cancel ] [ < Back l | Mext >

6. Follow the setup wizard instructions to complete the installation. On completion, an
Installation Complete window will display message “SPIROLA has been
successfully installed.” Click Close to exit.

7. SPIROLA item will be added to the All Programs menu on the Windows Start
menu, and a SPIROLA icon will be created on the Desktop.

8. When installing or uninstalling SPIROLA 1n future, the administrative database
SPIROLA Admin.mdb previously created by SPIROLA will be automatically
deleted if it is located in the same folder as SPIROLA software. For instructions on
how to protect an administrative database created previously by SPIROLA, see
section 3.2 below.
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3. Operating Instructions

3.1 Start and Close SPIROLA

To run SPIROLA, double click the SPTIROLA icon from the Desktop, or click the
SPIROLA program via Start > All Programs > SPIROLA.

A SPIROLA start screen will appear, as shown below. To close SPIROLA, on the File
menu click Exit, or just click the close button in the right upper corner of the window.

£} SPIROLA V2.0 [M=3

File Group Selection Individual Evaluation Group Evaluation Print  RiskList Tag Intervention Quality Control Options Help

[NIOSH

3.2 Open Datasets and Data Input
Open existing spirometry database

The first step is to open a SPIROLA dataset. For demonstration purposes the SPIROLA
package includes a demo dataset (C:/SPIROLA/DemoDataSet.mdb). See next section
for instructions on how to create user’s own SPIROLA database.

1. On the File menu click Open Database, as shown below.
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#E8 Group Selection  Individual Evaluation  Group Ewvaluation Print  RiskList Tag Intervention Quality Control Options Help

Cpen Database

Select administrative Database
Extract 4

Exit:

2. A window will appear as shown below. Click on the desired .mdb file (for example,
SPIROLA.mdb). If the dataset file is not in the current folder, click on the Look in
list, and then double click the drive and folder that contains the .mdb database file.

Click Open to proceed.
Open @E]
Look jn: | 3 SPIROLA v o icm
E Ziem b
| 5piro|a_Admin .mdb
My Recent
Documents
€
Desktop

My Documents

My Computer
Q File name: b I Open I
My Metwork  Files of lype: Access Files [ “mdb ) v Cancel

3. Click on a desired data table listed under Select a Table from Current Database as
shown below and then click OK to load the whole dataset into SPIROLA.

Note: User can select a subset of individuals whose last test is within a specified period.
To do that, click on Last Test and select the appropriate period for the most recent test.
SPIROLA will process the subset only during the current session. To apply the settings
next time SPIROLA i1s started, check Remember Selection.
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£ Load Spirometry Database File

Select a Database:

C\Documents and SettingsiDC3 ‘ | .|

Select a Table from Current Database:

DemoDataStandardFormat

Spircla Full

& Whole Data Set
O Last Test From: ‘ ‘ To: ‘ ‘

Remember Selection

‘ OK ’ ‘ Exit ’

Spirometry data input and format

SPIROLA requires demographic and spirometry data stored in or transported to a
Microsoft Access database (.mdb) as a data table. Tables sorted by ID and TestDate will
be processed faster. Each record should contain information on a single spirometry test
with the following fields and a specified type. Fields can be in any order and variable
names are not case sensitive.

The following variables are essential (must be included) for the SPIROLA analysis:

e ID - A text field (alpha numerical) to uniquely identify a tested individual (i.e., if
two different databases have similar values for ID field, but related to different
individuals, see Section “Open or locate administrative database” below). Also, to
speed up the data processing it is preferred that ID field contains only numeric values,
but it is not a requirement.

e Sex — A text field to store “M” for male or “F” for female gender

e Race — A text field to store “M” for Mexican-Americans, “B” for African-
Americans, or “W” for Caucasians and other groups. This variable is used for
selecting the appropriate set of reference equations.

e Age — A numerical field for age in years at a test (optional if date of birth provided)

e BirthDate — A date field (format: mm/dd/yyyy) to store date of birth (optional if age

1s provided). This field allows more accurate calculation of age, (e.g., 45.5 vs. 45)

Height — A numerical field to store height (cm) measurements of a tested individual

SPIROLA Ver. 2.0 5



e FEVI1 — A numerical field to store best FEV, (mL) value of a tested individual
e FVC — A numerical field to store best FVC (mL) value of a tested individual
e TestDate — A date field (format: mm/dd/yyyy) to store test dates

The following variables are optional for spirometry quality analysis:

FEV12 — A numerical field to store second best FEV; (mL) value

FV(C12 — A numerical field to store second best FVC (mL) value

QFEV1 — A character variable for FEV, quality grades (if available)

QFVC — A character variable for FVC quality grades (if available)

QTest — A character variable for session quality grades (if available)

Oper — A character variable for operator (spirometer technician) code or name
Provider — A character variable for a provider (e.g., a van service)

The following name variables are optional and are needed for a search by name:

e Last Name — A text field (Surname/family name)
e Middle Initial — A text field (leave blank if not available)
e First Name — A text field

Inclusion of names in the database enables the user to identify an individual by name
using Search for a Participant function in the Individual Evaluation menu. Also, if
both Last Name and First Name are provided, the reports will include full names of
tested individuals.

Additional fields containing, for example, weight, smoking status, cigarettes/day, asthma
status, or respiratory symptoms data can be added. These data will be shown at the
bottom of individual’s FEV chart, but will not be used in the analysis.

Importing data into SPIROLA

ATS/ERS guidelines on Standardization of Lung Spirometry, recommend a standard
format for databases generated by spirometers (Eur Respir J 2005; 26:319-338). All the
variables specified by SPIROLA are defined by the ATS/ERS guidelines to be included
in the standard database. At this stage the user needs to convert the spirometer-generated
database into an Access database, following the guidelines for format of the variables,
described above. The user can use Microsoft Access software to create or import the
spirometry data. To avoid data loss, all .mdb files should be backed up.

EasyOne Database Import. SPIROLA provides utility to import the data generated by
EasyOne spirometer. To import the data on File menu click on Extract Data and on
From EasyWare to access the import software. Click on Help and follow the
instructions provided. Future SPIROLA revisions will enable importing data from some
of other standard databases as well.
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Open or locate administrative database

Administrative database, SPIROLA Admin.mdb, contains information that SPIROLA
needs while processing the spirometry data. More specifically, the administrative
database stores the questionnaire results and intervention plans for individuals
participating in spirometry monitoring (i.e., records created using the Tag and
Intervention menus). To avoid data loss, the administrative database, as well as the
SPIROLA database, should be kept in a secured location that is regularly backed-up.

By default, when installing SPIROLA, the SPIROLA_ Admin.mdb database is created
in the installation folder and an existing SPIROLA_Admin.mdb is deleted. Therefore,
when installing or uninstalling SPIROLA, the user should safeguard an existing
SPIROLA Admin.mdb database that contains questionnaire or intervention data. This
can be done by creating or moving SPIROLA Admin.mdb to another folder or by
renaming the administrative database (e.g., SPIROLA Admin_textile.mdb). To create a
new administrative database 1n a different location or to rename it, on the File menu click
on Select Administrative Database (see above). A window will inform the user of the
current location of the administrative database (see below). Click on Create New
Administrative Database and select a new location or rename the database. By doing
this, the SPIROLA copies empty SPIROLA Admin.mdb from the Template Files
folder into the specified folder (i.e., the copied administrative database does not have any
questionnaire or intervention plan records). To copy an existing administrative database
into another location, the user should use Window Explorer. The Select Administrative
Database function is useful when an administrative database is shared by several users
and needs to be located on a shared disk space or in a secured location.

#\ Select Administrative Database g]

Note: Use only if the default settings of the administrative database are
to be changed.

Current administrative database: CASPIROLA New'\Spirola_Admin.mdb

I Locate Existing Administrative Database I

[ Create New Administrative Database ]

Remember Selection

3.3 Select a Group for Evaluation

Display invalid records or missing values

By default all participants are evaluated. To view observations identified to have invalid
data, click on Group Selection and Participants with Invalid Data. Values that are not
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valid are shown in red. To view individuals previously selected by the Risk List function,
click on Participants in Risk List. To restore to default, click on All Participants.

&3 SPIROLA V2.0

(e ahal=l S w 8 [ndividual Evaluation  Group Evaluation  Print  Risk List  Tag  Intervention Quality Control Options  Help

v All Participants
Participants in Risk List
Patticipants with Invalid Data

3.4 Individual Evaluation Menu

The Individual Evaluation menu provides a list of evaluations that can be done on an
individual.

File Group Selection Group Evaluation Print  Risk List Tag Intervention Quality Contral Options Help
FEW1 Evaluation
FWC Evaluation
Percent Predicted
Sumrmary Report

Multiple Charts View Charts
Chart Options

Search for a Participant

Monitor FEV, in an individual

1. On the Individual Evaluation menu click FEV, Evaluation to show a chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select the ID.
Alternatively, type the ID into the Search for Participant box (see above).
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Fie Group Selection Individual Evalustion Group Evaluation Print Risklist Tag Intervention Qualty Control Options Help

Longitudinal FEV1 Evaluation
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ID FirstName Middle Initial Last Name Sex Race Height Age FEV1 FVC TestDate FEV12Z FVC2 QFEV1
L) 918 DEWITT HAYS Male WHITE 180 36 QELFINN 5644  6/11/1993 4458 5593 D

918 DEWITT HAYS Male WHITE 180 37 | 4494 5572 BIANO94 4372 | 5454 A
918 DEWITT HAYS Male WHITE | 180 38 | 4260 5403 | 76M095 = 4223 | 5346 B
918 DEWITT HAYS Male WHITE = 180 39 | 4054 5003 | 411111996 4032 | 4926 B |,
< >
918 (DEWITT HAYS) ¥ Regr. Slope=-141mL/y  GroupSlope=-44mL/y  Swe76mL  Group Sw=178 mL

The individual FEV, chart shows: the observed FEV, values (green dots) plotted against
age; the linear regression line (green line) fitted to the observed FEV, data when at least 4
years of follow-up data are available; cross-sectional lower limit of normal (LLN), i.e.,
the lower 5™ percentile (purple line) and the lower 0.1™ percentile (comparable to 60%
predicted) (orange line). The percentiles help to determine the probability with which an
observed value is likely to occur in the reference population. U.S. population-based
reference equations are used by default,” but user can specify own equations (see Section
3.11). The blue solid line represents the limit of longitudinal decline (L.LLLD;) calculated
from the baseline observation(s). The default L1.D; is based on =10% annual decline, i.e.,
the default relative within-person variation of 4% and reference slope of 40 mL/yr (see
Section 5 and Section 3.11). This LLD; is used to identify excessive declines up to 8
years of follow-up. Observations that fall below LLD, should be evaluated as to whether
the decline represents data quality issue or true decline. The turquoise (greenish-blue)
dashed line represents the American College of Occupational and Environmental
Medicine (ACOEM) longitudinal limit of decline calculated as I.1.D=Baseline
FEVx0.85- yearsx30 mL/yr, based on 15% annual decline.® The user can select the
ACOEM limit for decision-making by selecting LLD; of 15% and referential rate of
decline of 30 mL/yr. See Section 3.11 on instructions how to change the default options.

Beginning with 4 years of follow-up, SPIROLA also tracks changes in the rate of FEV,
decline and displays this against the scale on the right axis. The brown dots show the
running rate of decline up to each data point and enable the user to discern the change in
the rate due to the last data point. The yellow dots show the running change in the slope
for the previous 8 years and enable the user to discern changes in the rate of decline in the
last 8 years. The three parallel lines represent 30, 60, and 90 mL/yr rates of decline.’
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The bottom margin displays the linear Regression Slope and Within-person variation (Sw)
for the individual who has 4 or more years of follow-up, and the mean Group Slope and
mean within-person variation Group sy, calculated as the averages of the individual linear
regression statistics.

Beginning with 8 years of follow-up, SPIROLA’s decision-making is based on the
estimated regression slope and the projected age when the regression (dashed green) line
crosses the 0.1® percentile (dashed yellow line). The blue dashed line shows the
longitudinal lower 95% confidence limit (CL) for the fitted regression line, estimated
from 8 years of follow-up data. This limit can be used to test whether the last observation
deviates significantly from the regression line predicted using all observations (Sections 4
and 5). To display the linear regression line extended beyond observed data, on the
Option menu click Display, Curves, General, and Show projected regression line as
shown below.

3 Chart Display Options @

Select Display Options:
FEV1 FVC | General

Show projected regression line O

Resetto Defaults
[ Apply } [ Exit J

The table below the chart shows the individual’s demographic and lung function data at
each test date. Other data, for example name, weight, smoking status, cigarettes per day,
quality control data, and a technician’s code will be shown also if included in the
SPIROLA database (see section 3.2).

Monitor FVC in an individual

1. On the Individual Evaluation menu click FVC Evaluation to show a FVC chart.
2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID.
Alternatively, type the ID into the Search for Participant box.
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File Group Selection Individual Evaluation Group Evaluation Print RiskList Tag Intervention Quality Control Options Help

Longitudinal FVC Evaluation
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ID First Name Middle Initial LastName Sex Race Height Age FEV1 FVC TestDate FEV12 FVC2 QFEV1 ©

» 918 DEWITT HAYS Male WHITE 180 | 36 5644 | G/11/1993 | 4458 5593 D

918 DEWITT HAYS Male WHITE 180 | 37 4494 5572 | 6/0994 | 4372 5454 | A

918 DEWITT HAYS  Male WHITE 180 | 38 | 4260 5403 | 70611995 4223 5346 | B

918 DEWITT HAYS | Male WHITE = 180 | 38 4054 5093 | 41111996 | 4032 | 4326 | 8
< >
918 (DEWITT HAYS) ¥ Regi Slope=-140mL/y  Sw=81 mL

The individual FVC chart shows: the observed FVC values (green dots) plotted against
age; the linear regression line (green line) fitted to the observed FVC data (when at least
4 years of follow-up data are available); cross-sectional lower limit of normal (LLN)
(purple line) and lower 0. 1 percentile (yellow line) (comparable to 60% predicted),
based on U.S. population-based reference equations.” Observations that fall below LLLN
should be evaluated as to whether the decline represents data quality issue or true decline.

Monitor percent predicted values in an individual

1. On the Individual Evaluation menu click Percent Predicted to obtain a chart with
percent predicted values for an individual person, as shown below.

2. Click the arrow next to combo box (ID box) on the left bottom corner to select an ID.
Alternatively, type the ID into the Search for Participant box.
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Longitudinal Percent Predicted and Ratio Evaluation
140%
Percent Predicted FEV1(green)
120% .
Percent Predicted FEV1(blue)
I e e R B T e e Bt
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~@- FEVA Percent Predicted @ FVC Percent Predicted - & - Observed FEV1FVC Ratio

ID First Name Middle Initial Last Name Sex Race Height Age FEV1 FVC TestDate FEV12Z FVC2 QFEV1I *

» |o18] DEWITT HAYS  Male WHITE 180 | 35 |[JECELN 5644 6111093 4458 | 5503 D
918 DEWIT HAYS | Male |WHITE | 180 | 37 | 4494 |5672 61994 | 4372 5454 | A
918 DEWTT HAYS  Male WHITE 180 | 38 | 4260 |5403 761995 | 4213 5346 @
918 DEWITT HAYS | Male WHITE 180 | 39 | 4054 | 5093 &/11/1996 | 4032 4926 8

<

918 (DEWITT HAYS) v

Display summary report

On the Individual Evaluation menu, click Summary Report to view results of an

individual’s data analysis and suggested course of action, as shown below (see Section 4

on evaluation methods). Click Print to print the Summary Report (see Section 3.6).

A SPIROLA V2.0

Bl Group Selection  [ndividusl Evaluation  Growp Evaluation Brkk Rsklst Teg Ipfervertin QuailyCorkrol Qotions Help

Spirola Report: DEWITT HAYS Date: 5/1/2009
ID: 918

Sex: Mele

Race: YWhile

Age: 38 years old

Date of last test: 411111996

Years of follow-up: 4 years and 5 monthe

Results of analysis:

Interpratation and suggested actions:
« Examine the quality of bassline and current test If confirmed that FEV1<LLDx, the rata of decline may be excassive

Last observation: FEV1 balow LLDr

Rate of FEV1 decline: Owverall 141 mlAear, 95% CI (100, 181)
Within-person varlation: 78 mL, within the normal range of 250 mL
Program variation: 193 mL, excessive (> 180 mL)

Examine the spirometry quality and retest to confirm the results. If the results are confirmed, consider further
evaluation, more frequent tasting, and intarvention

ID First Name Middle Initial LastName Sex Race Height Age FEV1 FVC TestDate FEVI2 FVC2 QFEV1 ~

L1ES DEWITT HAYE Male  White 180 36 4620 5644 EMINGE3 aane 5493 o

ns et HAYS Male  Vhne 180 31 4494 5572 WENERS 4317 9454 A

918 DEWITT HAYE Male  Yhie 180 38 4260 5403 16885 4123 5346 (]

919 DEWITT HAYS Male White 190 % | 4054 5093 | 4n1NGI6 4032 4926 o P
< >
018 (DEWITT HAYS) ~
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Display multiple charts

On the Individual Evaluation menu click Multiple Charts and Chart Options.

Select charts to be displayed together, as shown below, and click Apply and Exit.

£} Individual Evaluation Charts E|

to Show

Select Individual Evaluation Charts

Show FEV1 Evaluation
Show FVC Evaluation
Show Percent Predicted
Show Summary Report

Apply

display multiple charts, as shown below.

2. On the Individual Evaluation menu click Multiple Charts and View Charts to

£} SPIROLA ¥2.0

File Group Selection Individual Evaluation Group Evalustion Print RiskLlist Tag Intervention Quality Contral

Options  Help

Longitudinal FEV1 Evaluation Longitudinal FYC Evaluation
7000 60 ; 8000
6000 — 0g || 7ooo
-
m
= 5000 120 % 6000
2 : z 3 ""'1.
= 4000 s [ 5 s000
E \ 3 ’i \
B 3| =
= 3000 = 4000
El
2000 g 3000
1000 2000
20 25 30 35 40 45 50 55 60 65 70 20 25 30 35 40 45 50 55 60 65 70
AGE {years) AGE (years)
Longitudinal Percent Predicted and Ratio Evaluation Results of analysis: N
140 Last observation: FEWV1 belaw LLDr
Rate of FEV1 decline: Overall: 141 mL/year, 95% CI (100,
120 181)
Within-person variation: 76 mL, within the normal range of 250
F 100 o ‘lh.; —————————————— L
g a0 EEhaL, Program variation: 193 mL, excessive (=180 mL)
% 11 N N I O A O
Interpretation and suggested actions:
40 ® Exxamine the quality of baseline and current test. If confirmed that
FEV1<LLDr, the rate of decline may be excessive.
20 . . .
Examine the spirometry quality and retest to confirm the results. If
20 35 30 35 40 45 50 55 6O 85 70 the results are confirmed, consider further evaluation, more
AGE (years) frequent testing, and intervention. o
< >
ID First Name Middle Initial Last Name Sex Race Height Age FEV1 FVC TestDate FEV12 FVC2 QFEV1 ©
g1e DEWITT HAYS Male | White 180 35 4696 | 5728 | 32501992 4656 5638 B
918 DEWITT HAYS Male = White 180 36 4620 | 5644 | 6111993 4458 5593 D
a18| DEWITT HAYS Male | White 180 37 | 4494 5572 | 6i8/1994 4372 | 5454 A ™
< >
318 (DEWITT HAYS) ~ | Regr. SlopelFEV1 =141 mLYy  SwIFEV1)=76mL | Regr Slope(FVC)=-140mLsy  SwiFYC)=81 mL
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Search for an individual by name or identity number

1. On the Individual Evaluation menu click on Search for a Participant menu, as
shown below.

2. Type the person’s name or identity number into the corresponding spaces and click
on Find Participant. Alternatively, click on Find Participant, to list all individuals.
After an individual is selected, click Apply, to see the selected individual’s

evaluation.
3 Search for a Participant |j @]EI
Participant
D Last Name Middle Name First Name
[ Find Paticipant ]

ld LastName Middle Initial First Name Sex Race

Apply I [ Exit

3.5 Group Evaluation Menu

Group evaluation menu helps the user to monitor over time the following outcomes:
longitudinal FEV, data variability (i.e., the pair-wise within-person variation); group
means for FEV, and FVC; and the mean slopes of decline for FEV. All three charts can
be displayed in one window.

£} SPIROLA V2.0

File Group Selection Individual Evaluation REGHNEETEERGS Print Risk List Tag Intervention Quality Control Options Help

v Within-person Variation
Means For FEV1 Hlinal FEV1 Data Precision
Means For FYC

300
Wigw Mulkiple Charts

Group Slope
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Monitor longitudinal data precision in a group

1. On the Group Evaluation menu click on Within-person Variation to show the
yearly values of the pair-wise within-person variation s; (absolute) and s; (relative), as
shown below. The annual s, and s, statistics are calculated using FEV| measurements
repeated within 18 months. If the number of repeated measurements is small (<50) in
any one year, the sp and s; values are circled in yellow to indicate that the estimate
may not be reliable. The legend at the bottom of the screen shows the mean s}, and s,
values for the program.

3 SPIROLA ¥2.0

File  Group Selection  Individud Evaluaton  Group Evaluation  Print RiskList  Tao  Intervention Quality Control  Optiors  Help

Longitudinal FEV1 Data Precision
200 16

= 250 15
g i
= 2
S e
= 200 12 =
= 5 5
g \ ©
4 150 . 9 B
o
S S
5 5
5 5
s 100 ER—
> ./\//\ — 2
= '-\' =
=) =
3 A= 5
E & . =
0 0

1987 19849 1921 1993 il 1997 jEEtE 2001 2003 2005 2007
Follow-up year

-&-Sp - Sr

® The target for the program's varistion should be Sr below 4% |f Sr is above 4% focus should be on improving spimmetry guality

Y| MeanSp=193mL  Mean%i=k %

Monitor mean FEV, and FVC values in a group

1. On the Group Evaluations menu, click Means for FEV, (or FVC) to display yearly
group means for observed, predicted, and z-score (standard deviation units from the
predicted value) as shown below for FEV;.
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£ SPIROLA ¥2.0

File Group Selection IndwidualEvaluation Group Evaluation Print RiskList Tag Intervention Quaity Centrol Options Help

4700

4300

3500

3100

(W) LATS 104 vespy

2700

2300

1800

1987

8- Ohzerved FEV1

3900 /_/

1989 1991 1893

Predicted FEWY  —8- 7-Score

Trends for Group Mean FEV1

1995 1987 1999 2001 2003

Follow-up year

2005

2007

05

-0.5

210567

The mean FEV, chart shows group means for predicted (yellow), observed (green), and

z-score (red) values. Same applies for FVC chart. The predicted values are derived from
prediction equations that take into account age, height, sex, and race/ethnic background,

and are based on nationally representative healthy never-smokers.’ Irregular deviations of
observed mean values from predicted values may be due to changes in measurement

procedures, or due to effects of occupational exposure or interventions. Monitoring group

means can help to identify systematic effects taking place at a group level.

Display multiple charts

1. On the Group Evaluations menu, click View Multiple Charts to display the three

group evaluation charts together (see example below). This allows the user to review
changes in group FEV, and FVC means in relation to data precision.

SPIROLA Ver. 2.0
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3.6 Print Menu

1. To print a current plot, click Print, or Quick Print on the Print menu.

Evaluation results summarized in a medical report can be printed as individual charts
or in the Multiple Chart option (see example below).
3. To preview the report, click Print Preview on the Print menu and a printable report

will appear. Click one or two page display on the upper picture menu, as shown

below.

E8 Print preview

& LO- OO @GR @ Cose

SPIROLA Ver. 2.0
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3.7 Risk List Menu

Screen for individuals at risk of developing respiratory impairment

1.

On the Risk List menu, click Show Risk List Summary to create a list of individuals
whose rate of decline or within person FEV variation has been identified as
excessive or whose most recent lung function values (FEVy, FVC, or the FEV{/FVC
ratio) are below LLLN, as shown below. See Section 4 for the selection criteria.

£) Risk List =3

Summary

Total Individuals Scanned: 1500

Total with 2 or More Observations: 1445

Selected Into Risk List 572
Excessive Decline or Variation Last Observation Below LLN
FEV1 Below LLD: 156(10 8%) FEV1 Below LLN: 236(15.7%)
Excessive Slope: 38 FVC Below LLN: 230(15.3%)
Excessive FEV1 Variation: 173 FEVAFVC Below LLN:  188(12.5%)

Print Summary

Select Participants With

FEV1 Below LLD Excessive Slope FEV1/FVC Below LLMN
FEV1 Below LLN FVC Below LLN Excessive FEV1 Variation
Num. of Individuals Selected: 572

D FEV1 Excessive FEV1 FVC Below Ratio Excessive e
Below LLD Slope Below LLN LLN Below LLN FEV1 Variation
v K T S N T I N
2 10 0 0 0 0 1 0
3] 100 0 0 0 0 0 1
4 1005 0 0 1 1 0 0
5 1006 0 0 1 1 0 0
6 1009 0 1 0 0 0 0
7 101 1 0 1 1 1 0 v
I Evaluate ] I Show selected participant evaluation I l Print List l [ Exit ]

The results show the number of individuals screened and the numbers with each type
of outcome. Click on Print Summary to print the summary statistics only.

To evaluate a subset of individuals with a specific outcome, select the appropriate
outcome(s) shown under Select Participants With.

Click on Evaluate and select the method of evaluation from the Evaluation menus,
or click on Print List to print the list.

To identify a particular individual from the selected subset, place a pointer next to a
desired ID and click on Show selected participant evaluation.

To exit from the Risk List click on Exit.

3.8 Tag Menu

Tag individuals for further evaluation or intervention

1.

On the Tag menu, click on either Quality Control to tag an individual for a review
of spirometry tracings, on Re-Testing to re-test an individual in near future, or on
Intervention to develop an intervention strategies for an individual. Click on Add
Tag to add the person into a Tag List (see below).
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A Tag this record (=3
ParticipantID: 9138
Name: DEWITT HAYS
Tag History - Intervention
2 record(s) found. [ Display Full Text
Reason Dxte
Created
* 3/15/20089 Details. . | Delete
2 | Intervention 4/21/2009 Details... |Delete
Add New Tag
Tagfor |ntervention v
- |Intervention
F'“i@lual& Control
[ Add Tag ‘ BE

2. To display the list of individuals included in to the Tag List, on the Tag menu click

Tag List, and the list will be displayed as shown below.

) Tag History

Filter Crateria

Date Range: From: [y 111974 ~

Te: 41232009 v

Tag Type: |
Participant: g

Filter

Filtered Records
4 record(s) found

[ Display Full Text

Participant Tag Reason CrDeaatteed
4l Intervention 4121/2009 Details... Delste
2 918 Intervention 3/15/2009 Details... | Delete
3 az1 Quality Control /232009 Details... | Delste
4 922 Re-Testing 412312009 Details... | Delete

SPIROLA Ver. 2.0
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3.9 Intervention Menu
Design and review intervention strategies and questionnaire data

1. On Tag List select a participant and click on Detail. An Intervention Summary
window will appear, as shown below. To create a new questionnaire or an
intervention plan, click on New Questionnaire or New Plan. The Questionnaire List
and Plan List provide a history of previous records. Click on Edit to view the
previous entries. To delete an entry click on Delete.

£} Intervention Summary Q@@
Identification No.: 918 Date Created: 412142009
Name: DEWITT HAYS Date Last Updated: 4/23/2009

Questionnaire
List: 1 record(s) found.

Date Created Last Updated \L/
a ‘
»1 412312009 A123£2009 di Delete uestionnaire

Plan
List: 1 record(s) found

Date Created Last Updated
1 44232009 /232009 di

'

New Plan

Delete

Exit

2. Click on New Plan to display the default intervention options, as shown below.
Check on a selected intervention plan and click on View/Modify or Plan Detail to
proceed with developing the intervention plan for an individual. Finally, Save the
plan. To print a hard copy of the plan or to obtain a PDF file, click on Print Plan. To
go back to the Intervention Summary function click on Exit. The intervention plan
created for each individual will be permanently saved in the Administrative database
“SPIROLA Admin.mdb”. The user needs to sateguard the SPIROLA Admin.mdb
(see Section 3.2).
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£ Intervention Plan

Identification No.: 918 Date Created:

Name: DEWITT HAYS Date Last Modified:

Date Completed: 2

Comments:

[ Print Plan Summary ] { Print Plan

Preview the document before printing

Check the Intervention Check Date Completed
(W Safety intervention to be done: v ViewModify
2 Additional education/training provided: No ~ ViewModify
3 Repeated respiratory fit testing to be done: Mo ViewModify
4 Work modification agreement to be completed: No ~ Viewvodify
5  Lifestyle interventions: No View/Modifyy
6 Disease management: No ~ Viewivodify
7 Clinic Intervention (general medical fitness for respirator use): No v View/Modify
[ Plan Details ” Save } [ Exit ]

3. To modify an intervention plan template (i.e., to modify the questions that appear on
intervention plans), click on Intervention menu and then on Design Intervention

Plan as shown below.

) SPIROLA ¥2.0

File Group Selection

Individual Evaluation  Group Evaluation  Print

Risk List  Tag RGEEEERE Quality Control  Options  Help

Individual Details
Print Blank Questionnaire
Print Blank Intervention Plan

Design Intervention Plan

The example below shows a template for the default safety intervention module. The user
can change the description under each category, create new categories and sub-
categories, and change the type of data to be collected using the Design Intervention
Plan menu by right clicking on subcategories and selecting from the options (i.e., Add
Subcategory, Modify Category, or Delete Category). Changes to the templates are best
done at the planning stage of the intervention program. Changes made once the data
collection has started will make interpretation difficult, especially if new variables are
created. When the changes are completed, click on Save. All changes made to the plan
template will be saved permanently in the administrative database, which needs to be

safeguarded.

SPIROLA Ver. 2.0
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) Intervention Plan Template Designer

Intervention Plan Template Name: Default Intervention Plan Sample

Description:

This is the sample used by default for new plans

-~
§Safety intervention to be done: ‘No v | |- Adherence level -  ~||-- Succes
A. On site current exposure evaluation: ‘No 1
Add Subcategary
§I5Mas the person exposed on this job to: : Modify Categary
i pan Delete Cat
{Mineral Dust (e.g., cement, concrete, silica, asbestos) { [ s
§0rganin dust (e.g., wood dust, saw dust, grass) ‘ v
§Fumes, gases (e.g., diesel fumes, smoke, welding flux) ‘ v
§Metal fumes (e.g., nickel, chromates, copper, beryllium, v
icadmium, others) =
s s ‘ >

[ e [

4. To print blank questionnaire or blank intervention plan, on Intervention menu click

on Print Blank Questionnaire or Print Blank Intervention Plan and print the file.

If PDF writer software is installed on the computer (e.g., CutePDF Writer can be
downloaded for free from www.cutepdf.com), then the documents can be saved as
PDF files by selecting PDF Writer instead of a printer.

Print E| E‘

Frinter

M arme: CutePDF “/friter w [ Froperties. .. ]
CAPTURE FAX BVRP

Status: C

Type: Microsoft #PS Document \Writer
Send To OneMate 2007

‘Where:  Trwz

Comment: [ Print to file

Print range Copies

@ al Number of copies: 1 g

Collate
Selection @ ﬂ

[ Ok ][ Cancel J
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3.10 Quality Control Menu

Analyze quality grades assigned by a spirometer

1. On the Quality Control menu, click on Quality Control Indices, to obtain charts that

evaluate quality grades assigned from each test session by a spirometer. The Quality
Control charts are provided only if the quality grades are included in the SPIROLA
database (see Appendix on dataset creation). The example below shows: the
percentage of FVC (green line, square symbol) and FEV, (green line, circle symbol)
tests that do not meet the ATS/ERS acceptability and repeatability criteria; the
percentage of the tests that did not meet the ATS/ERS repeatability criteria for FVC
and FEV (blue lines); and the pair-wise within-person variation based on tests
repeated within 18 months. The charts are done for all tests and by individual
operators. This function is designed to monitor quality grades over time, overall and
by individual technicians (Operators).

" SPIROLA ¥2.0
Fle Group Selection Individusl Evalustion  Group Evalustion Prink  RickList Tag Intervention Quality Control Options  Help

Quality Grade, Repeatibility and Pair-wise Within-person Variation (%)

(9%) ebejussiag
1 s

Follow-up year

~&- QG FEV! -8 QGFVC - Aep FEVI -8 Rop FVC —#— St —a~ OG Teat

_Operator— ¥ MeanSp-200ml  Mean Si5%

3.11 Options Menu
List of options that can be changed from default

a referential rate of decline based on the actual data;
within-person variation based on the actual data precision;
critical limit curves displayed on an individual chart;
temporarily remove outliers from the individual data analysis;
choose units for height (cm or in);

SPIROLA Ver. 2.0
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e customize the reference equations.

The Option menu allows implementation of some of the options.

3 SPIROLA V2.0

File Group Selection Individual Evaluation Group Evaluation Print  Risk List Tag Intervention Quality Control Relslsy= Help

Referential Rate of Decline
Longitudinal FEV1 Evaluation within-person Variation ~ »
Display 4
Reference Equations

7000

Referential rate of decline

SPIROLA uses a default of 40 mL/yr for the referential rate of FEV; decline. The
Referential Rate of Decline option enables changing the default value. Studies indicate
that the mean rate of FEV decline in healthy never-smokers is about 30 mL/yr. To
achieve greater specificity of the limit of longitudinal decline (LLD) for moderate
impairment of lung function, a referential rate of decline based on all healthy individuals
regardless of smoking status, 1s used. In preliminary analyses, we determined this to
ranges from 40 to 45 mL/yr. For guidance, SPIROLA calculates the mean rate of decline
for the group using all individuals with four or more years of follow-up and shows the
result on the bottom margin of individual FEV, chart. Using the mean rate of decline as
the referential rate of decline together with the program’s average within-person variation
will result in identifying about 5% of declines as excessive.

On the Options menu, click Referential Rate of Decline and a dialog window will

appear, as shown below. Select a desired value from the list box, click Apply. To reset
back to default value of 40 ml/y, click on Reset to Defaults.

£} Referential Rate Of Decline @

Referential Rate of Decline (mLiyear): 400 v

‘ Reset to Defaults ’ ‘ Apply ’ ‘ Exit ‘

Within-person standard deviation

SPIROLA uses a default relative within-person standard deviation s; of 4% and the
corresponding L.LLD; based on =10% annual decline as being abnormal (see Section 5).
When ATS/ERS recommendations on quality control are followed, workplace monitoring
programs can achieve comparable data precision. These limits are goals that can help to
achieve a satisfactory level of data precision.

However, if the relative within-person standard deviations_, shown at the bottom of the
Group Within-person Variation chart, is significantly higher/lower than the default
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value of 4%, SPIROLA provides an option for changing the default value to the observed
5, value. If the 5_value is greater than 6%, then the LLD; of 15%, which corresponds to
the ACOEM limit, should be used and effort be made to improve spirometry quality.

1.

2.

On the Options menu, click Within-person Variation, and then click Relative
Value or Absolute Value, and a new dialog window will appear, as shown below.
Click the arrow button of Within-person standard deviation or Longitudinal limit,
and click on a desired value. If a desired value is not in the list box, enter the value.
Click the OK button to confirm the selection and Exit.

3 Within Person Variation El
Within-person standard deviation (Sr): 4 0% v
Longitudinal limit (LLDr): 10.1% v

‘ Resetto Defaults | | Ok | | Exit ’

Critical limit curves

On the Options menu, click Display, and then click Curves. A new dialog window
will appear, as shown below.

To enable or disable display of a critical limit curve, click the check box next to the
name of each critical limit curve. By default, all curves are checked except Absolute
LLD for FEV, and Show projected regression line for FEV; and FVC.

Click Apply to confirm the selections and Exit to exit this window.

&) Chart Display Options rz]

Select Display Options:
FEV1 ‘FVC General

LLN {5-th percentile)
0.1-th Percentile
LLD: ACOEM

LLD {(Absolute)

LLD {Relative)

B 088 &

Running rate of decline

=

‘ Resetto Defaults |

| Apply ’ ‘ Exit
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Show height in inches or centimeters

1. By default, each individual’s height is shown in centimeters in the data table. To
display height in inches, click Display on the Options menu, and then click Show
Height in ¢cm to remove the “check™ mark.

£3 SPIROLA ¥2.0
File Group Selection Individual Evaluation Group Evaluation Print RiskList Tag Intervention Quality Control ReliiEN Help

Referential Rate of Decline
Within-person Yariation 3 I
Curves

Reference Equations v Show Height in cm

Wihite: Backgroud

Display values of an observation on the chart

1. Place the cursor on any data point on the longitudinal FEV; evaluation chart, and then
right click. A small tooltip label will popup to show coordinates.
2. After a second, this tooltip label will disappear automatically.

Remove outliers from a longitudinal analysis

1. On the chart, place the cursor on any data point(s) which you want to temporarily
remove while processing the data, and then right click. The data point(s) will be
crossed out, and the regression line and other curves will be recalculated and redrawn.
To reload a data point, right click and include the observation in the analysis.

Note: The deleted data points are not deleted from the dataset, but only from the current

session. To permanently correct a data value, changes need to be done directly in the
.mdb database.
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Customize the reference equation for LLN and predicted values

1. On the Options menu, click Reference Equations to display a reference equation
window (see below). By default, SPIROLA uses U.S. population-based reference
equations based on NHANES III data.”

2. To customize the reference equations, select Custom Equation and type into the
table user-specific regression coefficients that correspond to those provided in the
equation above the table. If the equation does not include some specific parameters
(e.g., weight), let us know. Clock Ok and Exit to apply and save the new values.

£} Reference Equations @

Select Data Format:

US Population Reference Equations ‘Custﬂm Reference Equations

Lung function parameter=b0+b1*age+b2*age*2+b3*height*2
Parameter Sex Race bO(PRDILLN) b1 b2 b3PRD b3LLN ~
> FEV1 Male WHITE 0.5536 -0.01303 -0000172 000014098 0.00011607
2 FEV1 Male | AFRICAN-A 0.3411 -0.02309 0 0.00013194 0.00010561
3 FEV1 Male MEXICAN-A 0.6306 -0.02928 0 000015104 0.00012670
4 FEV1 Female — WHITE 04333 -0.00361 |-0.000194 |0.00011496 |0.00009283
5 FEV1 Female AFRICAN-A 0.3433 -0.01283 |-0.000097 |0.00010846 |0.00008546
6 FEV1 Female MEXICAM-A 04529 -0.01178 -0.000113 |0.00012154 | 0.00009830
7 FvC Male WHITE -0.1933 0.00064 -0,000269 |0.00018642 0.00015695
8 FVC Male | AFRICAN-A -0.1517 -0.01821 0.0 0.00016643 0.00013670
9 FVC Male  MEXICAN-A 0.2376 -0.00891 -0.000182 |0.00017823 |0.00014947
10 FVC Female  WHITE -0.3560 0.01870 |-0.000382 |0.00014815 0.00012198
11 FWC Female AFRICAN-A -0.3039 0.00536 |-0.000265 |0.00013606 0.00010916 -

ok | | Ext
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4. Methods of Evaluation and Interpretation of Results

Interpretation and suggested actions

The table below summaries “Results of analysis” and “Interpretation and suggested
actions” sections in the Summary Report, according to the duration of follow-up.
Individuals whose lung function is categorized as shown in the table are selected into
Risk List (see below).

Results | Interpretations and Suggested action(s)

Cross-sectional evaluation using the most recent spirometry results

If any of the results below: Examine spirometry quality and retest to confirm the results.
FEV,<LLN If confirmed that FEV|<LLN, the person has FEV| value that has only

5% probability of being normal. If the results are confirmed, consider
further evaluation, more frequent testing, and intervention.

FEV,/FVC<LLN If confirmed that FEV/FVC<LLN, results indicate airflow
obstruction. If the results are confirmed, consider further evaluation,
more frequent testing, and intervention.

FEV,/FVC>LLN and If confirmed that FEV,/FVC>LLN and FVC<LLN, results indicate a

FVC<LLNY} low vital capacity. If the results are confirmed, consider further
evaluation, more frequent testing, and intervention.

FEV,<0.1® percentile If confirmed that FEV,<0.1%® percentile, the person has FEV | value

that has only 0.1% probability of being normal. If the results are
confirmed, consider referral for clinical evaluation, more frequent
testing, and intervention.

Changes in FEV,over time with <8 years of follow-up

FEV,<LLDr Examine the quality of baseline and current test. If confirmed that
FEV<LLDr, the rate of decline may be excessive.
Rate of FEV, decline Prior to 8 years of follow-up, excessive decline is evaluated using the

LLDr limit. The rate of decline is provided as additional information
from 4 years of follow-up, but is not used in SPIROLA’s decision
making.

Within-person vanation >250 ml. | The within-person vanation =250 mlL. can be due to lack of spirometry
quality control. Consider correcting data errors before interpretation.
Occupational exposure, asthma, or personal factors can increase FEV,
variability.

Changes in FEV, over time with 8 or more years of follow-up

FEV<95%CL (derived from the | If confirmed that FEV;< 95%CL for the regression line, consider re-
regression line) testing in near future.

Rate of FEV, decline >90 mL/yr.’ | If a rate of FEV, decline >90 mL/yr is confirmed, results indicate
excessive FEV, decline. If the results are confirmed, consider further
evaluation, more frequent testing, and intervention.

Within-person variation >250 mL, | The within-person variation >250 mL can be due to lack of spirometry
quality control. Consider correcting data errors before interpretation.
Occupational exposure, asthma, or personal factors can increase FEV,
variability.

Projected FEV, declines to 0.1™ If projected FEV] regression line declines to 0.1™ percentile (=60%
percentile before 70 years of age. | predicted), results indicate increased risk of developing moderate
impairment. If the results are confirmed, consider further evaluation,
more frequent testing, and intervention.
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Risk List evaluation procedure

The Risk List identifies individuals who fulfill any of the criteria listed in the above
table. In evaluating an individual identified to be at risk of impairment the following
procedure should be considered.

1. Examination of the individual’s existing data

(1) Examine the longitudinal demographic, FVC, and FEV, data shown on the screen
in the table below the FEV; chart, to make sure that the data are reasonable.

(1) If a data point appears to be an outlier, temporarily exclude the point by right
clicking on it and then evaluate the new results on the chart and in the report.

(ii1)  If a single data point appears to be an outlier and causes the individual’s selection
into the risk list, check for possible data errors. The first (baseline) observation
may sometimes be lower due to the learning effect. When this happens, exclusion
of the baseline value may improve precision of the interpretation.

(iv)  If a data error is found, correct the data in the .mdb database using Microsoft
Access software, re-run SPIROLA, and review the new Summary Report.

2. Examination of the individual’s spirometry data quality

(1) Examine the original spirometry tracings using the ATS standardization criteria
of: (a) acceptability (extrapolated volume, cough in first second, end of test
criteria, obstructed mouthpiece, extra breath, cessation of airflow); and (b)
repeatability (<150 mL).’

(11) If an acceptability error is found, consider removing data for that test from the
dataset, correct the SPIROLA .mdb file using Microsoft Access, and then re-run
SPIROLA to produce a new Summary Report for the individual.

(111)  Provide feedback to the spirometry technician(s) on the spirometry errors found.

3. Re-test the individual

After the first two steps have been completed and SPIROLA still identifies the person as
being at risk, consider re-testing the person within six months from the most recent test.
If the re-tested spirometry values confirm the original interpretation, consider the
suggested actions in the new Summary Report.

Suggested intervention measures

When spirometry quality issues are satisfied and re-testing confirms that a person has
impairment or is at increased risk of developing respiratory disease, clinical evaluation,
implementation of more frequent testing, and intervention measures should be
considered. The severity of existing impairment and the rate of lung function decline
should be considered when deciding on the type of intervention(s).

Interventions on an individual level:

Discussing lung function results with a worker can motivate the individual and can help
to determine what course of action is acceptable to the individual to prevent further
excessive lung function loss. Decreasing inhalation of noxious particulates and gases is
usually the most important intervention. The most important risk factor for excessive
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decline in lung function in smokers is often tobacco smoking, for which nicotine
replacement therapy may provide best results for smoking cessation.'® Studies show that
complete smoking cessation is needed to halt excessive lung function decline.'!
Occupational exposures to respiratory hazards also represent an important risk.'
Evaluation of individual occupational exposures should be done. Where possible,
hazardous exposures should be reduced or eliminated through engineering controls (e.g.,
substitution of less hazardous materials, process enclosure, workplace ventilation).
Administrative controls (e.g., revised work practices) may also help limit hazardous
occupational exposures. Finally, use of effective personal protective equipment (e.g.,
respirators) should be recommended when other measures are infeasible or insufficient
by themselves. The potential synergistic effect of smoking and occupational exposure on
increased risk of excessive decline in lung function should be explained to individuals
who smoke and are exposed to occupational respiratory hazards. Weight gain can also
contribute to lung function decline due to loss of fitness and difficulty in performing the
spirometry test at full lung capacity. Body mass index (BMI) greater than 25 kg/m2 can
be associated with greater decline in lung function when other factors such as gender,
height, race, smoking, and respiratory symptoms, are controlled for.

Interventions at a company level:

Management commitment to an integrated worksite health and safety program provides a
key foundation for success in maintaining a healthy workforce. Programs are likely to be
more effective when they are based on management’s understanding of workers’
concerns about health risks on the job. By identifying workers’ priorities, smoking (for
example) can be addressed in the broader context of worksite safety. Intervention at the
individual level is then more likely to be successful.

Evaluation of the effect of intervention(s):

To determine the effect of individual intervention on the rate of FEV; decline using
SPIROLA, use the small rate of decline chart on the individual FEV, evaluation. To
determine the effect of an integrated worksite health and safety program using SPIROLA,
assess trends on the FEV; and FVC means for the whole group and for the at-risk
subgroup. An expansion of this feature is planned for a future version of SPIROLA.

5. Theoretical Background

The use of SPIROLA may help preserve lung function by:

(1) evaluating longitudinal data precision and promptly identifying when intervention
is warranted to maintain data precision at an acceptable level;

(1) identifying individuals with excessive decline in lung function using limits of
longitudinal decline (LI.Dr) based on the program’s actual data precision, or if
data precision can not be determined, based on the default criteria (i.e., s,=4% or
LLDr=10%) or the ACOEM longitudinal limit criteria (i.e., s,~6% or
LLDr=15%);

(i11)  1identifying individuals who already have lung function impairment using
ATS/ERS criteria based on cross-sectional data evaluation;
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(iv)  1dentifying when an individual’s lung function warrants individualized
Intervention measures;
(v) evaluating the effects of intervention at the individual level and the group level.

Evaluation of FEV, precision in a group

Monitoring a program’s data precision on an annual basis can help to identify and address
data quality problems soon after these occur and this way achieve and maintain high data
precision. To monitor data precision, SPIROLA calculates and charts yearly values of
the absolute within-person standard deviation s, and the relative within-person standard
deviation s;.*® These statistics are calculated on a yearly basis as the difference between
FEVi1; and FEV,; measured within 18 months of each other and summed overi=1,..n
individuals. (Note: this is not within testing session variance.) The year of the first
measurement determines the assigned year. A sample of about 50 individuals with
repeated measurements is needed to obtain a reliable estimate of yearly FEV, variation.

The absolute within-person standard deviation s, for a specific year is defined as:

s, = \/LZ(FEVIH ~FEVL,)?
2n ‘3

The relative within person standard deviation s, adjusts for each individual’s FEV | size
and for a specific year is defined as:

2
Al Z FEV1, —FEV1,,
2n 5\ (FEV1, +FEV1,)/2

i=1

The average values 5, = (1/ kN)Z(spn) and 5, =(1/ kN)Z(sl_n) are calculated by
summing the yearly weighteds and s, values over all years of follow-up and then
dividing by the total number of repeated observations N. These values represent the

average program-specific absolute and relative within-person variation, respectively. The
s,and s, values are shown at the bottom of SPIROLA’s Group Within-person Variation

chart as ‘Mean s’ and ‘Means . The mean within-person standard deviations 5, and

5. can be used to derive the program-specific limits of longitudinal decline (LLD) by
substituting these for the default values on the Options menu under Within-person
Variation option. When annual measurements are not available, SPIROLA provides the
group average within-person variation Group sy estimated from the linear regression
analysis done on each individual’s data from 4 years of follow-up. Generally there 1s
good agreement between these two methods of estimation.
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Note: If the sample of measurements repeated within 18 months 1s less than 50, the s,
and s values are considered unreliable and are indicated by a yellow color. If 5 and

5, values are not displayed or are based on a sparse sample, the user could use the default
LLD; value of 10% or change the default to LLD; of 15% as based on the ACOEM limit.

Estimation of limits of longitudinal decline for an individual

Because of inherent FEV, variability, it takes approximately 5-8 years of follow-up to
obtain a reliable estimate of the rate of FEV, decline in an individual.*® To identify
individuals with an excessive FEV decline within the first 8 years of follow-up,
SPIROLA uses by default the relative limit of longitudinal decline (LLD,).’ but the
absolute limit (LLD,) or the ACOEM limit based on 15% can also be used. These limits
are applied to determine whether the lung function decline between the baseline FEV,
value (or a mean of the first two observations, if the first FEV; value is lower than the
second one) and each follow-up FEV, value is excessive. Observations that fall below
the LLD warrant concern. The absolute or relative longitudinal limits are calculated using
a default value based on 10% annual decline. The user may change this to reflect the
average within-person FEV, variability for the group or the ACOEM limit based on 15%.

The absolute limit of longitudinal decline I.ILD, (mI./yr) is defined as a one-sided 95%
confidence limit:

LLD, = 7 x (b +1.645xSE(b))

where 7 1s the duration of follow-up in years and 2 is either the referent slope of decline
(up to 8 years of follow-up) or the individual’s estimated regression slope (beginning
with 8 years of follow-up). SPIROLA uses a default referent slope of decline of 40
mL/yr based on an analysis evaluating performance characteristics of the limit with
respect to sensitivity and specificity for long-term excessive decline in FEV;0f >90
mlL/yr and FEV; <60% predicted. The standard error of the slope b 1s defined as

SE(b) =5, 12(P=1)/ 1,/ P(P+1) (1)

where 7 is the duration of follow-up in years, P=2 represents two repeated measurements
done during the follow-up time 7 (the baseline and last observation), and &, 1s the

within-person standard deviation. By substituting the program-specific pair-wise
estimate of the within-person standard deviation s, for the within-person variation o, in

equation (1), one can estimate program-specific absolute LLD,.

The relative limit of longitudinal decline LLD, (%) standardizes for the magnitude of
FEV, and is defined as:

LLD, = x (b/FEV 1, +1.645%SEy(b)) )
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where FEV ), 1s the program-specific mean baseline FEV, and SE(b) is the approximate

standard error of b/FEVy, calculated by substituting the program-specific relative
within-person standard deviation 5, for o, in equation (1).

The limit for the actual value of FEV; (mL) below which an individual’s FEV, should
not decline after 7 years of follow-up without raising concern can be calculated in terms
of the individual’s baseline FEV, value and LLD, or LLD,, as follows:

FEV, = FEVy, - LLD,
or
FEV, = FEVy;, - FEV}, xLLD,

SPIROLA’s default value for the relative within-person variation s_1s 4%, which
corresponds to LLD; of 10% for /=1 (i.e., annual follow-up). The LLD; of 15% for =1,
which corresponds to the ACOEM limit, 1s based on 5, of 6%. To change this default
value, on the Options menu use the Within-person Variation option. Beginning with 8
years of follow-up, the interpretation of excessive decline is based on an individual’s
regression slope and the lower 95% confidence limit around the regression line calculated
as above. Here b represents the estimated regression slope and the individual’s baseline
measurement FEVy;, is replaced by the individual’s predicted FEV, value.

Cross-sectional evaluation to identify respiratory impairment

SPIROLA evaluates and reports for the most recent spirometry test whether the FEVy,
FVC, or FEV/FVC ratio values are below the respective “cross-sectional” lower limit of
normal (LLN) values or whether the FEV; value is below 0. ™ percentile. This approach
defines the individual’s value in terms of the probability of being normal based on
population distribution for individual’s characteristics (i.e., age, height, gender, ethnicity
or race). By default, the LLN values and the predicted values are calculated using the
U.S. population-based reference equations estimated separately for Caucasians, African-
Americans, and Mexican-Americans.” However, user-defined reference equations for
FEV,, FVC, and the FEV/FVC ratio can be specified.
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Appendix

Software requirements to run SPIROLA

Microsoft Windows 2000/ XP/Vista

Microsoft NET Framework 2.0 and Database engine. In most cases these software
packages are already installed on the user’s computer.

Microsoft Access 2003/2007 for viewing or editing data in Microsoft Access format.

If the NET Framework version 2.0 redistributable package is not already installed on the

computer, it can be installed by running the program DOTNETFX.EXE provided in
the SPIROLA software package or it can be obtained as a free download from
following

link: http://www.microsoft.com/downloads/details.aspx?FamilyID=0856 EACB-
4362-4BOD-8EDD-AAB15C5E04F 5&displaylang=en
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